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CPASoftware General Ledger (WIN) 
to Creative Solutions Accounting 
Conversion Guide 
The CPASoftware to CSA Conversion program and the Utilities / Data Conversion / 
CPASoftware command in Creative Solutions Accounting™ (CSA) are provided to convert your 
client data from CPASoftware™ General Ledger (WIN) Versions 2001.x – 2003.x into the 
Write-Up Solution® (WSW) bundle of modules within CSA. This conversion guide explains the 
necessary steps to convert your data, to identify the fields that will not be converted, and to 
document exceptions that you may encounter during the conversion process. The last section of 
this document explains the steps you should take to verify that the converted information is 
correct. 

Please read this entire document prior to starting the conversion of client data. You may refer to 
this document for all information regarding this conversion. 

Note: If you process After-the-Fact Payroll in CPASoftware, you cannot convert employee 
current-quarter and year-to-date balances for W-2 processing. For this reason, you should convert 
after finishing the payroll processing for a quarter or at year-end. For more information regarding 
the conversion of payroll amounts, please refer to the section of this document entitled “Items 
transferred during conversion of data from CPASoftware General Ledger” that begins on page 5. 
Also, refer to the section below entitled “Processing steps required for each client prior to running 
the conversion program” for further information. 

Conversion program overview 
The overall objective of the CPASoftware General Ledger to CSA conversion program is to 
provide a comprehensive conversion of your CPASoftware data to CSA. However, due to 
differences in processing calculations and data structures between CPASoftware and CSA, some 
CPASoftware data cannot be converted. Therefore, you should not expect to exactly duplicate 
results from CPASoftware using the converted data without adding or modifying the appropriate 
data in CSA. The specific items that cannot be converted and conversion exceptions are listed in 
the section of this document entitled “Conversion notes and exceptions,” which begins on page 9 
of this guide. 

Processing steps required for each client prior to 
running the conversion program 
 We strongly recommend that you make a backup of the CPASoftware client data before 

beginning the conversion process. The CPASoftware to CSA Conversion program will not 
change any of your CPASoftware data. If you need to modify the data in CPASoftware as 
part of the conversion process, this will allow you to restore the original. 
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 The CPASoftware to CSA Conversion program assumes that you have finished the processing 
period for the client in CPASoftware and that you will be processing the next period’s 
transactions in CSA. If you have already begun a new processing period in CPASoftware, you 
should not run the conversion until you have posted all transactions for that period. For 
example, if you are processing November for client 123, you should post the transactions in 
the November period in CPASoftware and then convert to CSA prior to entering any 
December transactions. 

Important! Transactions that have not yet been posted in CPASoftware will not convert to CSA. 
Be sure that the client has no unposted transactions by running the Edit List Printing command 
for each journal in the Journals of Original Entry menu. Post the transactions in each journal 
before running the conversion. 

Installing the CSA Conversion CD 
1 Insert the Creative Solutions Accounting Conversion CD into the CD drive on your 

workstation. 

2. From the Windows Taskbar, choose Start / Run and enter the command d:\SETUP (where d 
represents the letter of the CD drive that contains the conversion CD). 

3. Click the Install button to begin the installation program and respond to the prompts that 
appear on the screen. 

4. After the conversion program has been successfully installed, store the CD in a secure place. 

Notes 

 The conversion program is installed only on the local machine. You need to install the 
conversion program on each machine from which you will be converting client data. 

 After you have converted all of your accounting client data, you may remove the Accounting 
Conversion program from your workstation. From the Windows Taskbar, choose Start / 
Settings / Control Panel. In the Windows Control Panel, double-click the Add/Remove 
Programs icon.) 

Installing the CPASoftware to CSA conversion program 
You must install the CPASofware to CSA Conversion Wizard prior to creating the export files 
from CPASoftware, as explained in this guide. Complete the following steps to install the 
CPASofware to CSA Conversion Wizard. 

1. From the Windows Taskbar, choose Start / Run. 

2. In the Run dialog, type d:\CPAS2CS\SETUP (where d represents the letter of the CD drive 
that contains the conversion CD). For example, if you installed CSA using from your CD 
drive E, you would type E:\CPAS2CS\SETUP in the Run dialog.  



  (Over) 
 
CPASoftware General Ledger (WIN) to CSA Conversion Guide TL 11878 
Copyright 1998 – 2004 by Creative Solutions, a Thomson company. All rights reserved. Page 3 

3. Follow the prompts as they are displayed on the screen while the CPASofware to CSA 
Conversion Wizard install program is running. 

Installing the Access 2000 runtime program 
If you have Access 2000 already installed on your workstation, skip to the section below entitled 
“Converting the client data prior to import into CSA.” Otherwise, you must install the Access 
2000 runtime program. (Please note that if you are using Windows 2000, you must have Service 
Pack 3 installed before running this setup.) 

1. Insert the Creative Solutions Accounting Conversion CD into the CD drive on your 
workstation. 

2. From the Windows Taskbar, choose Start / Run. 

3. In the Run dialog, type d:\ACCESSRT\SETUP (where d represents the letter of your CD 
drive). For example, if E is the letter of your CD drive, you would type  
E:\ACCESSRT\SETUP in the Run dialog.  

4. Follow the prompts as they appear on the screen while the Access 2000 runtime install 
program is running. 

Converting the client data prior to import into CSA 
Use the following steps to create the CPASoftware General Ledger export files. The export file 
layout is a specially formatted file that can later be imported into CSA. The conversion program 
does not change your original CPASoftware data in any way. 

1. Start the CSI Conversion program by double-clicking the CSI Conversion icon on your 
desktop. If you did not install the shortcut, click the Start button on the Windows Taskbar and 
choose Programs / Creative Solutions / CSI Conversions. 

2. In the Conversion Type field, select Accounting. 

3. In the Competitor field, select CPASoftware – WIN version 2001.x to 2003.11. (Note that 
the Data Directory field is not accessible.) 

4. Click Start to open the CPASofware to CSA Conversion Wizard. 

5. When the splash screen appears, click Next. 

6. Enter the path to the CPASoftware database files that you wish to convert. For example, if 
your CPASoftware data files reside in your C drive, enter C:\CPAS\DATA. This will also be 
the default path to your CPASoftware data files during conversion. 

7. Click Next. 

8. Enter the client name / client ID for the client in CPASoftware. This company ID will be used 
in Step 5 of the section below entitled “Importing the converted client data into CSA.” 
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9. Click Next. 

10. Enter the client’s year-end date, current-period end date, and number of periods. This enables 
the conversion to extract the proper transactions and account balances for the current and 
prior period. 

11. Click Next. 

12. Enter a unique 5-character ID for this client. This 5-character ID will be used in Step 5 of the 
section below entitled “Importing the converted client data into CSA.” 

13. Click Next to begin the account mask analysis. 

14. Specify the account mask you used while creating the CPASoftware Chart of Accounts for 
this client. You must enter an X for core accounts and a D for departments. You should also 
include all account separators in the mask that are used in any GL account. For example, if 
you used 44444-EQ for equipment sales (with the EQ designating a department), you would 
type in XXXXX-DD. If EQ is just a sub-account, you would type XXXXX-XX for the mask. 

15. Click Next to begin the actual data conversion. After the conversion is complete, continue to 
the next section (“Importing the converted client data into CSA”). 

Importing the converted client data into CSA 
Use the following steps to import the converted data from CPASoftware into CSA.  

1. Start the CSA program by clicking the desktop icon for Creative Solutions Accounting. 

2. Create a new client in CSA by choosing New Client from the File menu. (For more 
information on creating a new client, choose CSA Help Topics from the Help menu and then 
search on New Client [File Menu] from the Index tab of the Help Topics dialog). If you are 
converting General Ledger and After-the-Fact Payroll information, you will need to select 
each of the following CSA modules when adding the client: General Ledger Solution,™ 
Payroll Compliance Solution, ™ and Financial Reporter Solution. ™ 

Important! You must complete the current period end date, current fiscal year end, and 
current payroll end date exactly as they appear in the CPASoftware system when you add the 
new client in CSA. For more information on setting the period-end dates and year-end dates, 
refer to the information under the heading “GL period and year-end dates” within the 
“Conversion notes and exceptions” section of this 1. 

3. From the Utilities menu, choose Data Conversion / CPASoftware. 

4. In the first field of the Import dialog, specify the location of the CPASoftware data files that 
you wish to import into CSA. This will be the same location you specified in Step 6 of the 
section above entitled “Converting the client data prior to import into CSA.” 
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5. Specify the client ID in the Client to import field, using the same 5-character ID that you 
entered in Step 12 of the section above entitled “Converting the client data prior to import 
into CSA.” 

6. Click the Import button. 

7. After the import process has been completed, you should make the necessary changes or 
corrections to the converted data as specified in the sections of this document entitled “Items 
transferred during conversion of data from CPASoftware General Ledger” and “Conversion 
notes and exceptions.” 

Items transferred during conversion of data from CPASoftware General Ledger 
The following tables are provided to identify fields in CPASoftware General Ledger that will be 
converted to CSA. The tables are organized by screens in CPASoftware and CSA and denote the 
necessary CSA screen navigation. 

GL account information 
CPASoftware GL 
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Account Number Setup / Chart of Accounts 
Acct# 

See “Conversion notes and exceptions” for 
more information on the conversion of the 
account numbers. 

Account Type Setup / Chart of Accounts 
Type 

The account type is assigned in the 
conversion program. 

Description Setup / Chart of Accounts 
Description 

The description in CPASoftware is 30 
characters in length, while the description 
in CSA is 29 characters in length. Only the 
first 29 characters will be converted. 

Current Yr Setup / Chart of Accounts 
Balance 

Current-year balances are calculated from 
the converted transactions for each period. 
See “Conversion notes and exceptions” for 
more information. 

Budget 
Maintenance 
Current Year 
Budgets 

Setup / Chart of Accounts 
Budget 

See “Conversion notes and exceptions” for 
more information on the conversion of 
budget amounts. 
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GL transactions 
CPASoftware GL 
Field Name 

CSA Menu Navigation 
CSA Field Name 

Comments and additional information  

Reference  Tasks / Transaction Entry 
Reference  

See “Conversion notes and exceptions” for 
more information on the conversion of the 
transaction references. 

Date Tasks / Transaction Entry 
Transaction Date 

 

Account # Tasks / Transaction Entry 
Account Number 

 

Payee/Description Tasks / Transaction Entry 
Description 

If no description has been entered in 
CPASoftware, the description “Converted 
Transaction” will be used by the 
conversion. 

Amount Tasks / Transaction Entry 
Amount 

 

 

Employee information 
CPASoftware GL 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Employee ID Setup / Employees 
General tab 
ID 

 

First Name Setup / Employees 
General tab 
First 

 

Middle Name Setup / Employees 
General tab 
MI  

CPASoftware allows 10 characters for the 
middle initial, while CSA allows only 1 
character. Only the first character will be 
converted to CSA. 

Last Name Setup / Employees 
General tab 
Last  

 

Address Setup / Employees 
General tab 
Street 

 

City Setup / Employees 
General tab 
City 
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CPASoftware GL 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

State Setup / Employees 
General tab 
State 

 

ZIP Code Setup / Employees 
General tab 
Zip 

 

Phone Number Setup / Employee 
General tab 
Phone 

 

Soc. Sec. # Setup / Employees 
General tab 
SSN/EIN 

 

Note: Employee balances cannot be converted.  

 

Vendor information 
CPASoftware GL 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Vendor Number Setup / Vendors 
General tab 
Vendor ID 

 

Vendor Name Setup / Vendors 
General tab 
Name 

The Name field in CPASoftware General 
Ledger is 40 characters long, while in CSA 
the Name field is 15 characters long. Only 
the first 15 characters of the name will be 
converted. 

Address 1 Setup / Vendors 
General tab 
Street 

 

City Setup / Vendors 
General tab 
City 

 

State Setup / Vendors 
General tab 
State 

 

ZIP Code Setup / Vendors 
General tab 
Zip 

 

Federal ID#  Setup / Vendors 
General tab 
SSN 

 



 

 

  (Continued) 
 
TL 11878 CPASoftware General Ledger (WIN) to CSA Conversion Guide 
Page 8 Copyright 1998 – 2004 by Creative Solutions, a Thomson company. All rights reserved. 

CPASoftware GL 
Field Name 

CSA Menu Navigation 
CSA tab 
CSA Field Name 

Comments and additional information 

Telephone Setup / Vendors 
General tab 
Phone 

 

Note: Vendor year-to-date amounts paid cannot be converted. 

Items not transferred during conversion of data from 
CPASoftware General Ledger 
Although most data from CPASoftware General Ledger is converted, some data cannot be 
converted due to differences in program features and data structures between CPASoftware 
General Ledger and CSA. The following items cannot be converted. 

General client information 
Client ID, name, DBA name, addresses, phone numbers, federal ID number, client type, period 
end dates, and whole-dollar balancing account cannot be converted. This information should be 
set up while adding the client in CSA. 

General Ledger information 
Current period, fiscal year end and period end dates, partnership percentages, source, ratio, graph 
and bank maintenance information cannot be converted. CPASoftware client accounts with 
account types other than VS or VP will not be converted as they are not needed in CSA for 
financial statement processing. 

Due to processing differences between CPASoftware and CSA, current- and prior-year account 
balances cannot be transferred. The beginning of year balances are converted and you will need to 
post your transactions in CSA after converting to get the monthly change amounts to appear on 
reports, etc. 

Budget amounts 
Current and prior-year budget amounts cannot be converted.  

Payroll setup, transactions, and employee earnings balances 
After-the-fact payroll setup information such as general payroll options, check entry defaults, 
state/locality information and report options cannot be converted. You will need to set these up in 
CSA. 

Although each payroll transaction is converted to each period’s GL transactions screen, these 
transactions are not converted to the payroll checkbook. Therefore, no payroll transactions are 
converted for payroll purposes from CPASoftware General Ledger to CSA. You will need to set 
up the pay codes and balances after the conversion has been completed.  
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Note: Only the After-the-Fact Payroll information in the CPASoftware General Ledger program 
converts to CSA. If the client had a corresponding CPASoftware Payroll client, the employee and 
vendor information from that program will not convert. The general ledger transactions posted to 
the CPASoftware General Ledger are converted. 

Journal entry information 
The CPASoftware Journals cannot be converted. If you require separate journals, you will need to 
set these up in CSA. All transactions posted to the year-to-date file will convert to the General 
Journal in CSA. Automatic adjusting entry information such as Auto Reverse Entries that have 
not been posted will not convert. Setup information for recurring journal entries, inventory 
adjustments, expense allocations, automatic distributions, and prior-period entries cannot be 
converted. 

Financial statements 
Report formats, report details, notes, and transmittal letters cannot be converted. 

Employee information 
Employment date, review date, birth date, termination date and reason, employee type, pay 
frequency, 401(K) rate or amount, labor and industry information, exemptions, W-2/1099 alpha, 
backup withholding, and employee pay/deduction balances cannot be converted. Employees 
whose pension, inactive, and deceased flags are marked are converted, but the flag is not set on 
the employee record in CSA. Employer payroll tax balances are calculated amounts in CSA and 
do not transfer from CPASoftware. 

Vendor information 
DBA Name, Phone 2, 1099 type, box and alpha field, and 1099 information cannot be converted. 
Due to data structure differences, vendor year-to-date checks, 1099 amounts, and balances cannot 
be converted. 

Note: Only the After-the-Fact Vendor information in the CPASoftware General Ledger program 
converts to CSA. If the client had a corresponding CPASoftware Payroll client, the employee and 
vendor information from that program will not convert. The general ledger transactions posted to 
the CPASoftware General Ledger are converted. 

Other information / Add-on modules 
Financial statement, labor and industries, wage report, and accounts payable information cannot 
be converted. 

Conversion notes and exceptions 
This section details all known conversion exceptions between data from CPASoftware General 
Ledger and the converted data in CSA. Conversion exceptions may include differences in field 
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lengths between CPASoftware General Ledger and CSA, required parsing of information from 
one field in CPASoftware General Ledger to multiple fields in CSA, manipulation of 
CPASoftware General Ledger data to conform with CSA requirements, and so on. 

GL period and year-end dates 
CPASoftware General Ledger allows you to set up from 1 to 13 processing periods for a client. 
You will need to set up the CSA client as an annual, quarterly, monthly, weekly, or 13-period 
client.  

If the CPASoftware client is a semi-annual client with two periods, set up the CSA client as a 
quarterly client and the conversion program will transfer balances to the 2nd and 4th quarters. You 
may either process in all quarters or use only those two to process the semi-annual information. 

If the CPA Software client uses anything other than the periods listed above, you will need to set 
up the CSA client as an annual client. All transactions will post to one period. 

If your client is a 13-period client or uses period end dates other than the end-of-the-month dates, 
make sure you also edit the period-end dates in CSA to match the CPASoftware client end dates. 

You may print a copy of the client’s period end dates in CPASoftware by choosing Setup and 
Maintenance, choosing Accounting Period Maintenance, pressing the ALT key, and choosing 
Print. Select a printer and press F5 to print. 

CSA combining accounts 
CPASoftware General Ledger departments are functionally similar to CSA departments, with one 
significant difference: CSA allows you to define “combining” accounts, which link individual 
department accounts and combine their amounts for reporting purposes. No transactions can be 
posted to the account and no balances need to be entered. These accounts are simply used to 
combine general balances for accounts that have already been posted to. For more information 
about setting up and using combining accounts, start the CSA program and search on 
“Combining accounts setup” from the Index tab of the CSA Help Topics dialog. 

Bank reconciliation information 
If you are converting a CPASoftware client and will be using the Bank Reconciliation features 
within CSA, all transactions will convert into CSA as cleared transactions for bank reconciliation. 
Therefore, if there are any transactions outstanding at the time of the conversion, you will need to 
enter them in the Initial Open Items dialog that is accessible from the Edit menu or F3 context 
menu when the Tasks / Bank Reconciliation window is active in CSA. 

Chart of Accounts mask 
The Chart of Accounts mask for clients entered in CPASoftware cannot contain alphanumeric 
characters. If the conversion detects the letters A-Z in the account mask, the conversion will stop 
and you will be instructed that the mask is invalid and you will need to renumber the chart within 
CPASoftware. 

The Chart of Accounts mask for clients converted from CPASoftware should be set up in CSA as 
either all core accounts or with three department locations. If the CPASoftware client contains 
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departmental accounts or if you wish to set up departments in CSA, you will need to set the Chart 
of Accounts mask in CSA to DDDCCCC. If the CPASoftware client does not use departments 
and you will not want to use the departmental features of CSA, you may leave the mask set as the 
default CCCCCCC.CCC. You may change the mask at another time if you wish. For more 
information on setting the Chart of Accounts Mask, search on “Chart Accounts Mask setup” 
from the Index tab of the CSA Help Topics dialog. 

Terminated employees / inactive vendors 
Employees with a termination date or vendors marked as inactive in CPASoftware General 
Ledger are converted to CSA to complete W-2s or 1099s for the current year. You will need to 
manually mark them as non-active in the CSA program after the conversion has been completed. 

Security 
Both CSA and CPASoftware allow user-level security in their programs, however the 
CPASoftware to CSA conversion program cannot convert user information such as password, 
user rights, user name, authorizations, etc. This information will need to be set up manually for 
the client in the CSA program. 

Verifying your converted data 
Although the conversion program has been designed to convert your data as accurately as 
possible, there are some instances when the conversion may not convert all data correctly due to 
data corruption or other anomalies within the CPASoftware General Ledger data. You should 
follow the steps below to verify that your CPASoftware General Ledger data has been converted 
correctly. 

1. Start Creative Solutions Accounting and open the new client that was created.  

2. Make all necessary changes as noted in the “Conversion notes and exceptions” section of this 
document, including the posting of transactions in each period of the current year. 

3. In CPASoftware General Ledger, print the Detail General Ledger and Trial Balance Report. 

4. In CSA, print the General Ledger and Trial Balance reports. 

5. Compare the reports. If the information contained on the CPASoftware General Ledger 
reports does not match the CSA reports, you will need to determine which transaction(s) are 
invalid or missing and then manually enter those transactions in CSA. Other reports are 
available in both systems if you cannot determine the discrepancy using the reports listed 
above. 

6. Compare the amounts on the CPASoftware General Ledger report and note any 
discrepancies. You can make manual changes to any payroll amount in the CSA program. 
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If problems are encountered 
If problems are encountered during the conversion of client data from CPASoftware General 
Ledger to your Creative Solutions Accounting software and you are unable to reconcile the data 
using the various reports and tools in CSA, contact CSI Product Support. 

Support 

Online Help 
For step-by-step procedures, refer to the online help. To learn how to use online help, choose 
Help / CSA Help Topics, click the Index tab, and search on “online help.” 

Website 
If you have questions or need assistance, you can visit our website at CreativeSolutions.com 24 
hours a day for access to our support knowledgebase and for the latest information on current 
issues and processing tips. To take advantage of this convenient means of accessing information, 
choose On the Web from the CSA Help menu, and then click Product Support and Service. 

Product Support 
To speak with a Product Support Representative, please call the CSI Help Line at 800-968-0600, 
press 3 for accounting support, and then listen to the options available before pressing the number 
for your product. Normal weekday support is available from 9:00 AM to 8:00 PM Eastern Time.  
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